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ABOUT THIS DOCUMENT 
The purpose of this addendum is to provide the user with information on the setup and use of EdgeTech’s 
Coverage Mapper. Although this addendum encompasses the latest operational features of the Coverage 
Mapper, some features may be periodically upgraded. Therefore, the information in this addendum is 
subject to change and should be used for reference only. 

This addendum should be used in conjunction with the corresponding user software and hardware 
manuals. 

Liability 
EdgeTech has made every effort to document the Coverage Mapper in this addendum accurately and 
completely. However, EdgeTech assumes no liability for errors or for any damages that result from the 
use of this addendum or the equipment it documents. EdgeTech reserves the right to upgrade features of 
this equipment, and to make changes to this addendum, without notice at any time. 

Warnings, Cautions, and Notes 
Where applicable, warnings, cautions, and notes are provided in this addendum as follows: 

CAUTION! Identifies a potential hazard that could damage equipment or 
data. 

NOTE: Recommendations or general information that is particular to the 
material being presented. 

Revision History 
REVISION DESCRIPTION DATE APPROVAL 
A Release to Customer 12/07/2016 CC 
B Update to Coverage Mapper 3/08/2018 HS 
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SOFTWARE SERVICE OVERVIEW 
EdgeTech provides software services free of charge. This software agreement does not address customer-
specified modifications or enhancements. These services may be ordered separately. Furthermore, 
EdgeTech software upgrades are meant for the sole use of EdgeTech customers. Any reproduction of 
EdgeTech-supplied software or file sharing is strictly prohibited. 

Software Updates and Enhancements 
EdgeTech customers can download new software releases with all modifications and enhancements from 
the Resource Center on the EdgeTech company website. Major software issues, should they occur, will be 
reported directly to the customer. New software releases consist of the following: 

• Software enhancements that are not on the price list 
• Software fixes and changes 
• Product integration 
• Documentation updates to online help 
• Tests for compatibility with other modules 

Software patches consist of software that has undergone the following: 

• Minor software enhancements 
• Software fixes and changes 

EdgeTech customers are entitled to contact EDGETECH CUSTOMER SERVICE by telephone, facsimile, or e-mail 
to report a difficulty, to discuss a problem or to receive advice on the best way to perform a task. When 
contacted, EdgeTech Customer Service will do the following: 

• Respond within 24 hours via Telephone, Facsimile, and E-mail Support  
• Immediately attend to serious problems affecting operations 
• Attempt to find an immediate work-around 
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CUSTOMER SERVICE 
Customer service personnel at EdgeTech are always eager to hear from users of our products. Your 
feedback is welcome, and is a valuable source of information which we use to continually improve these 
products. Therefore, we encourage you to contact EdgeTech Customer Service to offer any suggestions 
or to request technical support:  

NOTE: Please have the Coverage Mapper version available when 
contacting customer service. Clicking on the version in the Help > About 
box in the Coverage Mapper window will copy it to your clipboard. 

E-mail:  service@edgetech.com 

Mail:  4 Little Brook Road 
 West Wareham, MA 02576 

Telephone:  (508) 291-0057 

Facsimile: (508) 291-2491 

24-Hour Emergency  
Technical Support Line:  (508) 942-8043 

 

For more information please go to www.EdgeTech.com. 

  

http://www.edgetech.com/


vi 

 
 
COVERAGE MAPPER 0018975_REV_B 

COMPANY BACKGROUND 
EdgeTech (formerly EG&G Marine Instruments) traces its history in underwater data acquisition and 
processing back to 1966. EdgeTech has designed, developed, and manufactured products, instruments, 
and systems—for the acquisition of underwater data, including marine, estuarine, and coastal 
applications—for over 50 years.  

The company has responded to the needs of the scientific, Naval, and offshore communities by providing 
equipment—such as sub-bottom profilers, side scan sonar, acoustic releases, USBL positioning systems, 
and bathymetric systems—that have become standards in the industry.  

EdgeTech has also consistently anticipated and responded to future needs through an active research and 
development program. Current efforts are focused on the application of cutting-edge CHIRP and acoustic 
technology. 
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1.0 OVERVIEW 
EdgeTech’s DISCOVER Coverage Mapper is used primarily to assist in performing side scan surveys and 
ensuring adequate overlap on adjacent runs. The Towfish position (as calculated from GPS co-ordinate 
history, with user entered layback and offsets) is plotted in real-time on a 2-Dimensional latitude and 
longitude grid, along with the current bottom track coverage of the side scan sonar. Targets marked and 
then saved in the Target Logger application are also displayed on the same latitude/longitude grid as the 
Towfish track and coverage data. 

The Coverage Mapper application is a separate executable, normally located in the same folder as the 
DISCOVER.exe application. (Typically: C:\Edgetech\DISCOVERxxxx-FS\DISCOVERCoverageMapper.exe). 
There is normally a shortcut on the user Desktop to the application. If the Coverage mapper is selected in 
the external features tab it will auto-start when DISCOVER is started otherwise it can be independently 
started either before or after DISCOVER. 

When DISCOVER is running, the two applications share data to present the fish track history and coverage, 
and the Target Logger application provides marked and saved Target positions to the Coverage Mapper 
application. The DISCOVER Side Scan application must have a GPS receiver connected, providing valid 
position data during the survey. 

The Coverage Mapper application will also show the fish position and coverage history during playback of 
user created JSF files in DISCOVER Side Scan, provided the data had good GPS position data during the 
survey. Coverage history is also saved in a user designated folder in a file such as 20051220212635.enl. 
The file name represents the date and time of the history file creation (not data acquisition date). Such 
files may be created and re-loaded at any time. 
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2.0 OPERATION 
Coverage Mapper Operation is described below. 

2.1 Charts 
Coverage Mapper supports unencrypted S-57 Electronic Navigational Charts (ENCs). S-57 files typically 
have the extension *.000, and these can be added to the Coverage Mapper one-at-a-time or by folder, as 
shown in FIGURE 2-1. NOAA provides free ENCs for the United States. 

NOTE: Loading many ENCs is not supported. EdgeTech recommends 
using only a few at a time (< 3). 

Display options for ENCs can only be changed after the first ENC is loaded. 

Coverage Mapper can also display GeoTIFF and BSB images. Note that loading many images is not 
supported. Only use a few at a time. Large images may take a long time to load. 

 
Figure 2-1: ENC Loaded 
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2.2 ENL Files 
ENL files (*.enl) store coverage, track, and basic target information. Open ENL files to add their contents 
to the map layers. The user can remove all coverage, tracks, etc. from the layers with the Clear option. 
However, clearing does not delete files or affect recording. 

NOTE: Coverage Mapper always records. Recording cannot be turned off. 

Coverage Mapper only records coverage and targets sent to it. It does not record coverage loaded from 
ENL files. The user can change where ENL files are recorded to by changing the Project Folder, as shown 
in FIGURE 2-2. 

 
Figure 2-2: Loading an ENL File 
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2.3 File Menu 
Coverage Mapper's file menu allows the user to open coverage files (ENLs), start a new survey, open an 
old one, close the current survey, run a survey, and export a survey as a CSV file.  

 
Figure 2-3: File Menu 

In the File Menu, the user can also Import and Export Waypoints, refer to subsection 2.5.6, and open the 
Options window, which is described in the subsections below. 

2.3.1 General Options 
The General tab of the Options window contains a section for changing the units, one for selecting the 
project folder, and another for manipulating the various saved window layouts. 

2.3.2 Map Options 
The Map tab of the Options window allows the user to change the colors for various parts of the map and 
change the options for a displayed ENC. Refer to subsection 2.1. 

2.3.3 Survey Options 
The Survey tab provides options for changing the survey settings, including Run in / Run out, Line base 
name, Shape base name, and Plan Survey Speed. 

2.3.4 Advanced Options 
The Advanced options tab provides the user with the ability to manipulate the Connections (IP Addresses 
and Port Numbers), to set Coverage Display Limits, and to set GPS serial port numbers. The Advanced 
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Options are meant for users who are confident with changing these settings. If there is any question about 
how to use these options, contact EDGETECH CUSTOMER SERVICE. 

2.4 Display Menu 
The Display Menu has one option: Clear Coverage, which is discussed in more detail in subsection 2.5.2.9. 

2.5 View Menu 
The View Menu controls which screens are open in Coverage Mapper. A description of each is below. 

 

Figure 2-4: View Menu 

HELMSMAN LEFT-RIGHT INDICATOR | MAP | MAP LAYERS | PLAN SURVEY | RUN SURVEY | WAYPOINTS 
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2.5.1 Helmsman Left Right Indicator 
The Helmsman Left Right Indicator displays how far the boat is to the left or to the right of the current 
survey line being run. Refer to subsection 2.5.5 for information about running a survey. 

 
Figure 2-5: Helmsman Left Right Indicator 

Helmsman data can come from another Coverage Mapper. Refer to subsection 2.3.4. 

2.5.2 Map 
Manipulate the map by clicking and dragging on it to see another area. This action is called panning. To 
zoom in and out, use the mouse wheel or magnifying glass icons. 

NOTE: There are no built-in charts at higher resolutions (tighter zooms). 
The map background will appear blank when zooming in close by default.  

As the mouse moves, the position under it (latitude/longitude) is displayed in the bottom left corner of 
the screen, as shown in FIGURE 2-6. 
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Figure 2-6: Coverage Mapper Main Screen 

Clicking on the map does different things depending on which tool is being used, with the move map tool 
being the default. Switch tools using the toolbar or by right clicking on the map, as shown in FIGURE 2-7. 

 
Figure 2-7: Switching Tools 
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2.5.2.1 Move Map Tool 

In the move map tool, the user can also find out about targets. Click once on a target to see its name. 
Double click on a target to send it to the Target Logger if it is connected. 

 
Figure 2-8: Getting Target Information 
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2.5.2.2 Range and Bearing Tool 

Range and bearing and area measurements can also be taken by clicking on the appropriate icon, clicking 
the area, and dragging, shown in FIGURE 2-9. The measurements are displayed in the bottom near the 
position display. When done measuring, set the tool back to the move map tool to enable panning. 

 
Figure 2-9: Measuring the Area 
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2.5.2.3 Survey Line Tool 

The Survey Line Tool allows the user to draw lines by clicking and dragging on the map when the tool is 
selected, as shown in FIGURE 2-10. 

 
Figure 2-10: Survey Line Tool 
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2.5.2.4 Line Spacing Settings 

Most survey line tools allow the user to specify line spacing. Equal spacing sets all the lines to be added 
the same distance apart. Range and overlap also uses equal spacing, but the spacing amount is calculated 
from the set range and overlap using this formula: (2 x range) – overlap. The efficient pattern alternates 
spacing between the set major and minor spacing, as shown in FIGURE 2-11.  

 
Figure 2-11: Line Spacing Settings 
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2.5.2.5 Survey Box Tool 

When Survey Box Tool is selected, a new survey box can be drawn by clicking and dragging on the map. 
The box can be filled with lines or can be empty for surveys when the user needs to "paint the screen." 

 
Figure 2-12: Adding a Survey Box 

Click and drag anywhere on the map with the move and rotate tools to adjust the box. The user does not 
need to click near the box to move or rotate it. 
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2.5.2.6 Survey Shape Tool 

With the Survey Shape Tool selected, the user can click to add points to the shape. Like the survey box, 
the shape can be filled with lines or left empty. Click and drag anywhere on the map with the move tool 
to position the shape. The user does not need to click near the shape to move it. 

 
Figure 2-13: Adding a Survey Shape 

2.5.2.7 Survey Base Line Tool 

Clicking anywhere on the map with the Survey Base Line Tool activated adds points to the base line. Using 
the move tool with this feature works the same as the other shape tools. 

 
Figure 2-14: Adding Points using the Survey Base Line Tool 
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2.5.2.8 Follow Boat & Towfish Check Box 

When the Follow option is checked, the map follows the boat when it moves off-screen. 

 
Figure 2-15: Map Following Boat 

2.5.2.9 Clear Coverage Tracks Button 

The user can also remove all coverage, tracks, and targets with Clear.  

NOTE: Clearing does not delete any files or affect recording. 

 
Figure 2-16: Before and After Tracking Lines Removed 
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2.5.2.10 GPS Check Box 

When GPS Check Box is checked, Coverage Mapper will read from a GPS plugged into computer via USB 
(or RS-232). What port and baud rate used can be specified in the advanced Serial Ports section of Options. 

 
Figure 2-17: GPS Check Box 

CAUTION: When Coverage Mapper reads the GPS, DISCOVER cannot. 
Only one program can read the GPS at a time. Therefore, Coverage 
Mapper GPS feature should be turned off (unchecked) before attempting 
sonar data acquisition with DISCOVER. 

2.5.3 Map Layers 
The Coverage Mapper organizes map content into layers, as shown in FIGURE 2-18. Each successive layer 
builds upon previous ones. Thus, it is a good idea to keep charts at or near the beginning of the layers list. 

Features of the Layers include: 

• Add predefined types of layers 
• Remove layers 
• Reorder layers with drag and drop 
• Change layer opacity 
• Temporarily hide layers 
• Zoom to show a layer’s content 

 
Figure 2-18: Manipulating some of the Layers’ Options in Coverage Mapper 
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2.5.4 Plan Survey 
Survey plans consist of lines, shapes, or both, and can be saved as Survey Plan Files. The files are 
automatically saved as changes are made to the plan, and modifications can be made to an existing plan. 
However, there can be only one survey plan file open at a time. 

The Plan Survey Window, as shown in FIGURE 2-19, allows the user to: 

• Remove lines and shapes 
• Reverse lines 
• Edit point positions 
• Launch the survey drawing tools 

 
Figure 2-19: Plan Survey Window 
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2.5.5 Run Survey 
The Run Survey in where the survey is conducted, geographically. The window allows the user to Start or 
Stop running a line, go to a previous or next line, and reverse lines. 

 
Figure 2-20: Run Survey Window 
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2.5.6 Waypoints 
Waypoints can be imported and exported via File menu, or added directly on the map. In Waypoints 
window, the user can: 

• Display, highlight or hide waypoints on map 
• Edit waypoint's name or position 
• Delete waypoints 

 
Figure 2-21: Manipulating Waypoints in the Waypoints Window 

2.6 Window Menu 
The Coverage Mapper remembers window layouts, and allows the user to name and apply customized 
layouts at any time. Windows are also dock-able, meaning that they can snap, or stick to different places 
on the screen. Right-clicking the top window reveals these docking options. 

 
Figure 2-22: Window Menu 

The window layout can also be reset to the default by clicking the appropriate menu option. 
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2.6.1 Save Window Layout 
Saves the current Windows Layout for future use.  

2.6.2 Apply Window Layout 
Applies a previous Window Layout to current settings.  

2.6.3 Manage Window Layouts 
Allows the user to manage existing Window Layouts.  

2.6.4 Reset Window Layout 
Restores Windows Layout to the fault.  

2.7 Help Menu 
The Help menu item will bring up the module's built in Help Documentation, along with information about 
the Current Version, and an option to create a log archive. 

 
Figure 2-23: Help Menu 

NOTE: If you have any further questions about Coverage Mapper, contact 
EDGETECH CUSTOMER SERVICE. 

2.7.1 Coverage Mapper Help 
This activates an interactive Help Menu, which will address most user questions.  

2.7.2 Creative Log Archive 
 

2.7.3 About 
Provides information about the current Version of Coverage Mapper.   
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A.0 Legacy Coverage Mapper Description 

The legacy coverage mapper has been described in this appendix for customers who still have this version 
of the utility. For more information, contact EDGETECH CUSTOMER SERVICE. 

An example of the Legacy Coverage Mapper screen is shown in FIGURE A-1. 

 

Figure A-1: Coverage Mapper Screen Example 

The Coverage Mapper can be user configured to: 

• Auto Pan (follow ship with fixed zoom factor) 
• Auto Zoom (shrink scale as region is expanded) for larger areas of coverage. 

The user may customize all the colors of the Coverage Mapper display such as: background, targets, grids, 
Towfish position, high and low frequency coverage, port and starboard, etc. 

Coverage marks for indicating both the high frequency and low frequency system ranges. 

Fish Track 

Actual Ground 
Range, Port Side 

Marked Target Position 

Current Cursor Position 
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 Figure A-2: Coverage Marks for HF and LF  

Direct measurement of distance between two points on the Mapper screen, in meters, is provided by 
using the mouse RIGHT “click and drag” function. See above. 

Other features and controls provided are: 

• Zoom IN/Zoom OUT 
• Re-center screen on Fish Position 
• Pan Up/Down (North/South) 
• Pan Left/Right (East/West) 
• Measure Area or Length 

Users may select track items to be displayed/hidden (Boat Position, Fish Position, Targets, Coverage, etc.). 

The coverage mapping feature uses significant amount of the CPU's resources. The following are the 
recommended minimum system specifications: 

• Display: Dual Screen Support 
• Memory (RAM): 512 Mbytes minimum 
• CPU:  Pentium 4 

A.1 Operation 
As sonar data is acquired by the DISCOVER Side Scan application, the following data is sent in real-time to 
the Mapper application: 

Target Position (Cursor) 

Range to Target 
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• Current true ground range of side scan (affected by Bottom Tracker or manual fish height 

estimate) 

• Navigation position of the survey vessel 

• User entered Towfish layback (see DISCOVER 4200 Software Manual). 

These parameters are used to plot the position of the ship, Towfish, and coverage area on the 2D 
latitude/longitude-based grid. Since the Towfish's internal compass is used to show the its heading, it is 
important that the compass is properly calibrated. (See Towfish Manual for instructions). 

Targets marked and saved in Target Logger are sent to Coverage Mapper for plotting on the 2D grid.  

For more information on the new Target Logger, see the provided addendum in the Manuals Folder: 
Target Logger Software Module Addendum [0018974]. 

All data used to construct the coverage map are saved as *.enl files for later recall. These files do not 
consume much space; however they will need to be erased periodically to keep disk clutter down. 

A.2 Window Layout 
Coverage Mapper Window layout is labeled in FIGURE A-3, and described in the following sections: 

 
Figure A-3: Window Layout 

Re-Center Screen 

Pan Left, Up, Down, Right 

Measure Area (Right 
 Zoom In/Out 

Start New Mapper File 

Measure Length (Right 
 

Open Mapper 
 



2-23 

 
 
 

A.2.1 Control Icons 
The control icons, from left-to-right, are described as follows, as shown in FIGURE A-3. 

START NEW MAPPER FILE:  This clears the display screen of all information, closes the current file, and 
starts a new file. 

OPEN MAPPER FILE: This opens an existing file, and displays the data onscreen. Subsequently acquired 
data is augmented to the display. 

ZOOM IN/OUT: These change the scale factor of the display. The mouse scroll button (if equipped) 
performs the same function. 

MEASURE LENGTH: LEFT click on this to change the mouse right click function to measure linear length in 
meters. 

MEASURE AREA:  LEFT click on this to change the mouse right click function to measure area square 
kilometers. 

PAN LEFT, UP, DOWN AND RIGHT:  Moves the center of the display to the side shown by the arrow. 

RE-CENTER SCREEN: Forces the screen to be re-centered on the current fish position. 

A.2.2 File Menu 
The file menu is described as follows: 

NEW: Click this to clear the screen and start a new file. 

OPEN: Select a file for display in the window that opens. 

EXIT: Select to exit the DISCOVER Coverage Mapper module. 

A.2.3 Configuration Menu 
The configuration menu is described as follows: 

FOLDER SELECTION: This allows the user to choose the folder for storing Coverage Mapper files. 

AUTOMATIC ZOOM: When selected, the display zoom factor is adjusted to ensure the Towfish position is 
displayed on screen 

AUTOMATIC PAN: When selected, the display zoom factor is kept constant and the display is panned to 
ensure the Towfish position is displayed on screen 

A.2.4 View Menu 
The view menu is described as follows: 

TOOLBAR: Toggles display of the shortcut toolbar on the top of the screen. 
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SHIP POSITION: Toggles display of the ships position on/off. 

FISH POSITION: Toggles display of the tow fish’s position on/off. 

TARGETS: Toggle suppression or display of target position on display. 

COVERAGE HF: Toggle suppression or display of HF system coverage on display. 

COVERAGE LF: Toggle suppression or display of LF system coverage on display. 

ZOOM IN: Zoom in one scale factor. 

ZOOM OUT: Zoom out one scale factor. 

COLORS: Allows user selection of each of the color of each of the displayable parameters. 

RE-CENTER DISPLAY: Forces the display to be re-centered on the current or latest fish position. 

NOTE: There is an interaction between Coverage Mapper and Target 
Logger where in when the user double left clicks a target icon in the 
Coverage Mapper, it will be recalled and opened in the Targets Logger 
screen for review. 
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